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1. Introduction 

1.1 Overview 

This whitepaper outlines how to perform live backups of your Exchange Server‟s entire information store 

database. If you need to backup individual mailboxes from an Exchange Server see our Exchange Mailbox 

Add-on whitepaper located on our online education centre: http://www.backupassist.com/education  

1.2 Requirements 

To backup and restore your Exchange Server information store using BackupAssist you need the following: 

 BackupAssist v5 

 Windows 2000, XP, Server 2003, or Server 2008. 

 Microsoft Exchange Server 2000, 2003, or 2007 

 Windows Backup (NTBackup) / Windows Server Backup (wbadmin) 

The Windows Backup program includes facilities to perform live, online backups of an Exchange server. 

This means that the Exchange Server does not have to be stopped to perform an Exchange backup.  

BackupAssist uses this feature of Windows Backup, whilst also working around several bugs in Windows 

Backup to deliver a reliable solution. Using BackupAssist you can select and backup local and remote 

Exchange Server storage groups, which can then be used to restore an entire Exchange server, including 

public folders. 

BackupAssist also comes with a plug-in into Windows Server Backup (Server 2008) that makes it Exchange 

aware and capable of properly backing up Exchange Server 2007. This overcomes the limitation that 

Windows Server Backup is natively not Exchange aware. 

1.3 Remote backup of Exchange 2007 requirements 

If you are attempting to backup a remote Exchange 2007 server you will need to install the Exchange Server 

Management Tools on the machine where BackupAssist is installed. BackupAssist should be installed on a 

machine running Windows 2000, XP or 2003. 

1. If you have installed BackupAssist on a 32-bit operating system: 

Download and install the Exchange Server 2007 Management Tools (32-bit): 

http://www.microsoft.com/downloads/details.aspx?familyid=6BE38633-7248-4532-929B-

76E9C677E802&displaylang=en  

2. If you have installed BackupAssist on a 64-bit operating system: 

Install the Exchange Server 2007 Management Tools (64-bit) from the installation disc or download that 

was used to install Exchange 2007 on your remote server. 

In addition, if you have installed a version of Exchange Server 2007 that came pre-packaged with Exchange 

2007 Service Pack 1, you will need to make a small alteration to the Windows registry due to a change made by 

Microsoft.  

Note: if you installed Service Pack 1 after installing Exchange Server 2007 the change should not be required. 

http://www.backupassist.com/education
http://www.microsoft.com/downloads/details.aspx?familyid=6BE38633-7248-4532-929B-76E9C677E802&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=6BE38633-7248-4532-929B-76E9C677E802&displaylang=en


WHITEPAPER 
Exchange Server Backup and Restore 4 

 

© Cortex I.T. 2001-2007 

 

Excerpt from Microsoft article:  

As part of the Microsoft continuing security initiatives, Microsoft Exchange Server 2007 Service Pack 1 (SP1) 

introduces a behavior change designed to reduce the attack surface of the system. This change directly affects 

remote streaming backups on Windows Server 2003. 

To adhere to the Microsoft Secure by Default initiative, the remote streaming functionality disabled (server-wide) 

in Exchange 2007 SP1 is disabled by default. A manual override in the form of the following registry value must 

be enabled to restore this functionality: 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\MSExchangeIS\ParametersSystem  

Name: Enable Remote Streaming Backup 

Type: DWORD 

Value: 0 = default behavior (remote backup disabled); 1 = remote backup enabled 

Refer to http://technet.microsoft.com/en-us/library/aa998870.aspx for full instructions. 
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2. Backing up an Exchange Server on Windows XP, 

2000 or Server 2003 

2.1 Creating a backup job 

Before you can select your Exchange Server for backup you will need to first create a backup job in 

BackupAssist. If you already have a backup job configured for this purpose you should skip to section 2.2. 

If you are running BackupAssist on a Windows 2000, XP, or 2003 machine and need to backup Exchange Server 

either locally or remotely, complete the following to create a backup job: 

Note: refer to section 1.3 for remote Exchange backup requirements. 

1. Launch BackupAssist and from the File menu select New backup job.  

2. Select NTBackup and click Next.  

3. Continue configuring your backup job according to your requirements. Exchange backup will be 

configured once the job creation is complete. 

4. If you do not need to select data in the Files and folders step click Next and then Ignore when prompted.  

Once you have created your backup job you will be presented with the job edit window:  

 

 

 

 

 

 

 

 

 

We will now discuss how to add an Exchange Server to your backup job using the Exchange Servers Window.   

There are two types of Exchange Server backup available: 

 Information store: entire Exchange server database  

 Individual mailbox: brick-level backup of user mailboxes (requires the Exchange Mailbox Add-on) 

We will only be focusing on Exchange information store backup in this whitepaper. Refer to the Exchange 

Mailbox Add-on white paper for details on how to backup individual mailboxes. 

2.2 Adding an Exchange Server to your backup selections 

To add Exchange Server backup to your NTBackup job configuration: 

1. From the left menu under Job settings select Exchange Servers. 

2. Within the Exchange Server selection section click Add Exchange Server. A window will appear that 

displays all of the available Exchange Servers on the network. 
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Note: Exchange Servers residing on a different domain to that of the machine where BackupAssist is 

installed will not be detected and cannot be backed up. 

3. Click Add to add all of the available Exchange servers to your backup selections.  

4. Check Backup storage groups for each Exchange Server you want to backup. 

5. Now select which storage groups to backup for each Exchange Server:  

o Check Select all storage groups if you wish to backup all storage groups and any future storage 

groups that are created (recommended). You can exclude specific storage groups if required by 

unchecking them, but all future storage groups created will still be backed up.  

o Or, leave Select all storage groups unchecked and individually check each storage group to 

backup. No storage groups created in the future will be backed up, only those selected. 

6. Click Apply changes when you have finished making your selections. 

2.3 Performing a backup of your Exchange Server 

To test your Exchange Server backup you can either run your backup job manually or wait for the next scheduled 

backup to occur.  

For NTBackup jobs BackupAssist backs up your Exchange Server during the second phase of the backup 

process, after the selected data files and system state (both optional) have been backed up. This helps to 

eliminate an issue with Windows Backup (NTBackup) where a backup of both the system state and Exchange 

Server information store in the same pass fails. 

To run a backup of your Exchange Server manually: 

1. Click Quick actions from the top menu of BackupAssist and select Run now. 

2. Choose Run a future backup and click Run. 
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During the backup process you can view the job‟s progress in the Monitor window: 

 

Notice that for NTBackup jobs it is during Phase Two that the information store of your Exchange Server is 

backed up.  

2.4 Examining your backup logs 

Once the backup completes, to ensure that your Exchange Server was backed up correctly you should examine 

the backup report: 

1. Click Reports in main navigation bar of BackupAssist. 

 

2. Double-click the latest report in the list of a job that includes Exchange. 

 

3. For your NTBackup job, scroll down to the specific section in the report for Exchange Server backup: 
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In this example, two different storage groups were backed up. The report will indicate that status of the 

backup and verify of each storage group selected. Successful backup and verification is denoted by a green 

tick  and unsuccessful backup and verify with a red cross . 
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3. Backing up an Exchange 07 Server on Server 2008 

3.1 Creating a backup job 

If you are running Exchange Server 2007 on Server 2008 and want to back it up locally with BackupAssist, 

complete the following to create a backup job: 

1. Launch BackupAssist and from the File menu select New backup job.  

2. Select Windows Imaging and click Next.  

3. Configure your backup job according to your requirements, and ensure that you select the volumes that 

contain your system data and Exchange data when choosing what files to backup. 

Once you have created your backup job you will be presented with the job edit window. Exchange will be backed 

up automatically when your backup job runs at its scheduled time. 

Exchange Server data will be automatically backed up as long as the volumes where your system data and 

Exchange data reside have been selected in the Volume selection window (access „job settings‟ from the left 

menu).  

3.2 Performing a backup of your Exchange Server 

To test your Exchange Server backup you can either run your backup job manually or wait for the next scheduled 

backup to occur.  

For Windows Imaging jobs, when the backup runs, BackupAssist will automatically detect if Exchange Server 

2007 is installed, and if installed, it will perform the consistency checks and log file truncation required to correctly 

backup Exchange Server 

To run a backup of your Exchange Server manually: 

1. Click Quick actions from the top menu of BackupAssist and select Run now. 

2. Choose Run a future backup and click Run. 

During the backup process you can view the job‟s progress in the Monitor window: 
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3.3 Examining your backup logs 

Once the backup completes, to ensure that your Exchange Server was backed up correctly you should examine 

the backup report: 

1. Click Reports in main navigation bar of BackupAssist. 

2. Double-click the latest report in the list of a job that includes Exchange. 

3. For Windows Imaging jobs your backup report will include an Exchange Database Consistency Check 

report, and the Exchange System Manager will indicate when the last full backup occurred on your 

Exchange Server: 
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4. Restoring an Exchange 03 or 07 Server on Server 03 

In the following example three steps are carried out to perform the Exchange Server restoration for Exchange 

backups created using NTBackup. This example follows from the backup process completed during section 2. 

This example assumes that the system is functioning properly and that Exchange Server is installed on the 

system.  

If you backed up Exchange Server 2007 using Windows Server Backup via a BackupAssist Windows Imaging 

job, please use Windows Server Backup to restore your Exchange Server, and refer to the Windows Server 

Backup documentation for the required restoration steps. 

4.1 Dismounting Exchange Server stores 

Before you can restore your Exchange Server database you will first need to dismount the stores you are 

restoring to: 

1. Launch the Exchange System Manager from the Start menu. 

2. Expand the Servers tree to locate the appropriate server and storage group (screenshot below).  

3. Right-click each store listed individually (typically Mailbox Store and Public Folder Store) and select 

Dismount Store: 

 

4. Your stores should have an icon with a red arrow to indicate that they have been dismounted: 
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4.2 Using Windows Backup to perform the restoration 

Run Windows Backup (NTBackup) to restore your Exchange Server database: 

1. Go to Start Menu > All Programs > Accessories > System Tools > Backup 

2. If Windows Backup launches in Wizard Mode click the Advanced Mode link 

 

3. [Optional ï remote restore]: If you are restoring to a remote Exchange Server click the Backup tab and 

then select Tools > Remote store from the top menu and enter the name of your remote Exchange Server. 

4. Now click the Restore and manage media tab. 

5. Locate the backup file or tape you wish to restore from and expand this tree until you locate the Exchange 

Server Information Store. 

6. Select each storage group you wish to restore: 

 

7. Click Start Restore. You will be prompted with several choices: 
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o In this example we are restoring to a local Exchange Server so the Restore To field has been 

filled with the computer name of the local machine. 

o The Temporary location for log and patch files should be any directory with enough free space 

to perform the restore and Windows Backup will create the directory if it does not already exist. 

o If you are restoring a full backup of Exchange ensure that the last two options are checked. If you 

are restoring an incremental or differential backup, you should refer to the section 4 for additional 

resources. 

8. Click OK to begin the restore of your Exchange Server. 

4.3 Checking the restore logs 

Once the restore is complete, you should see the following window: 

 

Click Report to view the logs The backup log will show the results of the Exchange Server restore operation: 

 

If the logs do not indicate any errors, we recommended that you now reboot your server. Your Exchange 

information store should now be restored, mounted and operational. 
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5. Restoring an Exchange 07 Server on Server 08 

Exchange can be directly restored using the Windows Recovery Environment on Windows 2008 from backups 

made through BackupAssist.  

Please note: some of the instructions outlined here are available in the Windows Server Backup help file.  

5.1 Perquisites for recovery process 

Before attempting to restore Exchange 2007 using Windows Server Backup from a drive image backup created 

with BackupAssist, make sure of the following: 

You are completing the restore with Windows Server 2008. Windows Vista only provides support for drive 

volume restore.  

The backup you wish to restore from is located on an external hard drive. 

To restore your Exchange 2007 server you must be a member of the Backup Operators or Administrators 

group, or you must have been delegated the appropriate authority. 

The following registry key will need to contain the string value highlighted below: 

 

 

 

 

 

 

 

 

 

 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\WindowsServerBackup\Application Support\ 

String information 

String name: Application Identifier 

Data: Exchange 
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5.2 Performing the recovery 

After ensure that you have met all of the above prerequisites please follow the below steps to restore your 

Exchange 2007 server: 

1. Launch the Exchange Management 

Console by navigating to Start > All 

programs > Microsoft Exchange Server 

2007 > Exchange Management Console. 

 

2. Expand Server Configuration from the 

left pane and select Mailbox. 

 

3. Right-click each database listed in the 

middle pane individually and select 

Dismount Database. 

 

 

 

4. Once the databases have been dismounted, right-click 

each database individually and select Properties and then 

check This database can be overwritten by a restore. 

 

 

 

 

 

 

 

 

 

 

 

 

5. Start by launching BackupAssist and click Restore in the 

navigation bar.  

 

6. Click Imaging engine restore to launch the Windows 

Server Backup console. 
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7. Click Recover under the Actions pane.  

 

8. Once the Recovery Wizard has launched, 

select “This server”, and then click Next. 

 

 

 

 

 

 

 

9. Select the date from the calendar and the 

time from the drop-down list of the backup 

you want to restore from. If you are 

recovering from this computer and the 

backup you select is stored on a removable 

media drive, you will be prompted to insert 

the relevant media.  Then click Next.  

 

 

 

 

 

10. When asked what you would like to recover, choose the option for Applications, and click Next.  

 

11. Under Applications, highlight “Exchange”, and then 

click Next. 

 

12. Under Recovery destination, select Original 

location, and then click Next. 

 

13. Review the details, and click Recover to restore 

your Exchange Server.  

 

14. You can then view the status of the recovery operation and whether or not it was successfully completed. 

 

15. Once recovery operation completes successfully, 

return to the Exchange Management Console (step 

1) and mount each of the restored databases by right-

clicking each one individually and selecting Mount 

Database.  
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6. Restoring Exchange 07 mailboxes via the Recovery 

Storage group on Server on Server 08 

Exchange can be directly restored using the Windows Recovery Environment on Windows 2008 from backups 

made through BackupAssist.  

Please note: some of the instructions outlined here are available in the Windows Server Backup help file.  

6.1 Perquisites for recovery process 

Before attempting to restore Exchange 2007 using Windows Server Backup from a drive image backup created 

with BackupAssist, make sure of the following: 

You are completing the restore with Windows Server 2008. Windows Vista only provides support for drive 

volume restore.  

The backup you wish to restore from is located on an external hard drive. 

To restore your Exchange 2007 server you must be a member of the Backup Operators or Administrators 

group, or you must have been delegated the appropriate authority. 

The following registry key will need to contain the string value highlighted below: 

 

 

 

 

 

 

 

 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\WindowsServerBackup\Application Support\ 

String information 

String name: Application Identifier 

Data: Exchange 

6.2 Performing the recovery of your data from an Image backup 

After ensure that you have met all of the above prerequisites please follow the below steps to restore your 

Exchange 2007 server: 

1. Start by launching BackupAssist and click 

Restore in the navigation bar. 

 

2. Click Imaging engine restore to launch the 

Windows Server Backup console. 
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3. Click Recover under the Actions pane.  

 

 

4. Once the Recovery Wizard has launched, 

select “This server”, and then click Next. 

 

 

 

 

 

 

5. Select the date from the calendar and the 

time from the drop-down list of the backup 

you want to restore from. If you are 

recovering from this computer and the 

backup you select is stored on a removable 

media drive, you will be prompted to insert 

the relevant media.  Then click Next.  

 

6. When asked what you would like to recover, 

choose the option for Applications, and click 

Next.  

 

 

 

7. Under Applications, highlight “Exchange”, 

and then click Next. 

 

8. Under Recovery destination, select Recover 

to another location, select a directory 

located on the Exchange server, then click 

Next. 

 

 

 

 

9. Review the details, and click Recover to restore the Exchange Server databases to your chosen directory.   
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6.3 Creating and populating the Recovery storage group. 

1. Once the recovery process has completed navigate to the directory containing the backup of your storage 

group. You will need to rename all of the files in this directory beginning with an „E‟ to begin with „R‟. This 

includes all of your log files. 

 

Initially you will have: 

 

 

After the renaming you would have: 

 

 

2. You will now need to create a Recovery Storage Group to mount the database you are restoring. Begin by 

launching your Exchange Management Console and opening the Disaster recovery toolbox from the 

Toolbox node in the Exchange tree. 
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3. When the Disaster recovery toolbox loads you will need to specify you server‟s name in order to connect 

to it. Enter the required details and click Next. 

 

4. We will now make a Recovery Storage group. Click Create Recovery storage group to being the process.  

 

5. Once the wizard begins select the storage group 

you are going to restore to the RSG, then choose 

Next. 

 

 

6. It is recommended that you use the default 

settings for the creation of the recovery storage 

group for ease of recovery. Make a note of the 

Recovery database path as you will need it in a 

few minutes. Once you have done this click Create 

recovery storage group and complete the wizard. 

 

 

 

 

 

 

7. Once you have completed the wizard, launch an explorer window and navigate to the Recovery database 

path. Copy the renamed files from step 1 into this folder. 

 

8. After copying the renamed database files go back to the Disaster recovery toolbox and click Mount or 

dismount databases in the Recovery storage group. Select the newly created RSG and mount it. 

 

6.4 Performing merge from your Recovery storage group. 

 

1. Once the RSG has mounted and you have returned 

to the menu of the DRT, click Merge or copy 

mailbox contents. 

 

2. Ensure that the correct mailbox is present in the 

recovery storage group selection then click Gather 

merge information. 

 

3. Double check the merge details then click Perform 

pre-merge tasks. 

 

4. Select the mailboxes you wish to merge and then 

choose Perform merge actions. 

 

5. You will be presented with the merge results; check 

that all tasks were successful and then click Go back 

to task centre. 

Don't forget to remove the Recovery storage group after you have finished with it. This can be done via the 

Remove the recovery storage group option from within the disaster recovery toolbox. 
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7. Additional Resources 

Microsoft Technet has some very detailed articles on Exchange Server. These are very technical in nature, and 

are suitable for system administrators. The following specific resources may prove useful, particularly if you are 

looking to perform a Differential or Incremental restore of your Exchange Server. 

Resource Web Address 

Exchange 5.5 Disaster Recovery http://www.microsoft.com/technet/prodtechnol/exchange/55/supp

ort/exdisrec.mspx  

Exchange 2000 Server Database Recovery http://www.microsoft.com/technet/prodtechnol/exchange/2000/su

pport/dbrecovr.mspx  

Exchange Server 2003 Disaster Recovery http://technet.microsoft.com/en-us/library/bb125070.aspx  

Exchange Server 2003 Administration 

Guide 

http://www.microsoft.com/downloads/details.aspx?FamilyId=98E4

5481-1458-4809-97D6-50D8AEEBD8A1&displaylang=en  

Exchange Server Resources http://technet.microsoft.com/en-us/exchange/default.aspx  

 

http://www.microsoft.com/technet/prodtechnol/exchange/55/support/exdisrec.mspx
http://www.microsoft.com/technet/prodtechnol/exchange/55/support/exdisrec.mspx
http://www.microsoft.com/technet/prodtechnol/exchange/2000/support/dbrecovr.mspx
http://www.microsoft.com/technet/prodtechnol/exchange/2000/support/dbrecovr.mspx
http://technet.microsoft.com/en-us/library/bb125070.aspx
http://www.microsoft.com/downloads/details.aspx?FamilyId=98E45481-1458-4809-97D6-50D8AEEBD8A1&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=98E45481-1458-4809-97D6-50D8AEEBD8A1&displaylang=en
http://technet.microsoft.com/en-us/exchange/default.aspx

